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1. THE eCAFE™ — TAKE IT TO GO!

Thank you for trusting Hercules by choosing to purchase the eCAFE™ netbook. The eCAFE™ has been designed to allow you to
communicate and create or edit documents such as text files, slideshows or even images; it also includes advanced multimedia features
designed to entertain you.

To make the most of your eCAFE™ nethook, please follow the instructions provided in this manual.

A A number of operations that you can perform on your eCAFE™ will require you to provide a password. The default user account
password is "ec-900", and the administration account password is "root".

You can change these passwords in the Security thumbnail of the Computer Configuration application.

1.1 Handling your netbook

A Please read this section with care before using the
product.

Like any electronic device, the eCAFE™ requires you to observe a number of simple safety rules; these are listed below. In addition, observing
some simple precautions will enable you to extend your eCAFE™'s life.

- In no circumstance should you attempt to open the eCAFE™, its adaptor or its components; doing this would expose the device's internal
components to damage. Likewise, never attempt to open the device's batteries.

- Use only the adaptor provided with the product.
- Always place your eCAFE™ on a horizontal, stable and flat surface.
- Never exert pressure on the display. Never touch the display with any objects that are liable to damage it or scratch it.

- Always make sure that you have removed any objects placed on the device's keyboard (e.g. USB key, pen or others) before closing your
eCAFE™'s display.

- To avoid any risk of fire or electric shock, always keep your eCAFE™ away from:
- Rain or moisture, as well as all fluids (water, chemical products and any other liquids),
- Heat sources such as radiators, cookers or other heat-emitting devices (including amplifiers),
- Direct sunlight.
- This product should be used only at temperatures ranging from 5 to 35°C.
- Never cover your eCAFE™ while the device is powered on.
- Always unplug your eCAFE™ before cleaning it. To clean it, use a soft cloth; avoid using chemical sprays.

- The eCAFE™ provides a WiFi wireless connection feature. Use of this feature is liable to cause interferences with the equipment located on
planes or in hospitals. Always deactivate this feature before entering these premises.

- Always deactivate the WiFi feature during thunderstorms.
- Never throw the device's batteries into an open fire.

- When transporting the eCAFE™, always turn the device off if you are carrying it in a closed bag. As a general rule, make sure that your
eCAFE™ is placed in a well-vented environment when the device is powered on.

1.2 A comprehensive package
Compact design, an ultra-lightweight device, powerful connectivity, various accessories included. Discover the packaging contents:

- eCAFE™ personal computer
- Battery

- Power adaptor

- Quickstart guide
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1.3 A closer look at your eCAFE™

- 1.6 GHZ Intel® ATOM™ Processor

- 512 MB DDR2 (SO-DIMM) RAM

- 8.9" backlit LCD screen (max. resolution: 1024 x 600 native)
- Built-in 1,300,000-pixel webcam, built-in microphone

- Built-in Intel® 945GSE video card, built-in sound card

- Built-in WiFi 802.11 b/g/N card

- 1.8" 60 GB PATA/ZIF hard drive

- Rechargeable 6000 mAh (6-cell) lithium battery

- 100-240 V, 50/60 HZ mains adaptor

- 3 USB 2.0 ports (compatible with USB 1.1 devices)

-1 10/100 MBps Ethernet port

-1 VGA outlet

- 1 headphone input, 1 microphone input

- 80-key keyboard

- Touchpad with 2 buttons

- Multi-format memory card drive for (Secure Digital), SD HC (Secure Digital HC), MMC (MultiMedia Card)
- Weight: less than 1.2 kg with the battery

- Dimensions: 225 mm x 168 mm x 33 mm

The included operating system is specific to your eCAFE™. It is based on the latest Linux Mandriva operating system, and includes all the
essential applications you may require to you use your netbook at home or "on the road". It can however be extended via the "Computer
Configuration" application.
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2. eCAFE™ — UNEQUALLED AND UNRIVALLED

The eCAFE™ nethook features a very wide range of applications and extensive connectivity interfaces, which will enable you to instantly
connect to the world that is best suited to your use: work, communications, games or multimedia.

2.1 My eCAFE™

© O)

O© ® O

1. Webcam 6. Hard drive activity indicator ~ 10. Right button
light
2.8.9"LCD screen 7. Battery usage indicator 11. Touchpad
light
3. Microphone 8. WiFi indicator light 12. Headphone input
4. English keyboard 9. Left button 13. Microphone input

5. Mains power usage
indicator light
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1. Removable battery 3. Air intake vent 5. DDR RAM bay
2. Battery locking latches 4. Speakers

A This part of your eCAFE™ is liable to heat during operation and charging. This is normal. However, to improve thermal dissipation, we
recommend you do not block the vents. Avoid placing your eCAFE™ on a soft surface such as a sofa or a bed, for instance.
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1. Power cord socket 3. USB 2.0 port
2. VGA outlet 4. Memory card drive

1. USB 2.0 ports 2. LAN/Ethernet ports 3. Kensington® lock
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2.2 Multifunction keyboard

eCAFE™ features a complete keyboard that lets you control the screen and WiFi connection settings.

ctivate/Deactivate witch from the
Activate/Deactivat Switch from the LCD
WiFi feature (default is olE display to an external
inactive) ) display (For more
information regarding the
screen resolution, please
refer to the
T - Activate/Deactivate Personalisation Wizard,
J‘l audio output section 3.7.2. Extensive
— contents to take you
further)
Reduce volume = Putcomputer in standby
J s ‘ mode
Increase volume i 1l ol Lock/Unlock the numeric
e
Reduce display Lock/Unlock the scroll
brightness lock function

Increase display
brightness

Switch  between  full
screen  display and
window display modes in
the Internet browser
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2.3 A netbook suited to large files

Equipped with a hard disk drive and a multiple-format card reader, the eCAFE™ enables you to take your most precious files with you,
regardless of their size.

Hard disk drive

The eCAFE™ features a 60 Go (or more, according to versions) hard disk drive, user space is approximately 50GB. This storage capacity
allows you to save movies, images and other large files to your device.
Memory card drive

The eCAFE™ is equipped with a multiple-format memory card reader supporting SD and SD HC (Secure Digital), MS (Memory Stick®), MMC
(MultiMedia Card) formats; this device enables you to view pictures taken with your digital camera or to extend your system's storage capacity,
for instance.

USB ports

The eCAFE™ is also equipped with three USB ports that enable you to connect a USB storage key or other USB devices (for further
information regarding USB ports, please refer to section 2.4, "Extensive connectivity options for countless applications").

]

2.4 Extensive connectivity options for countless applications

The ports and connectivity interfaces built into your eCAFE™ enable you to connect all kind of USB peripherals, such as a mouse or an
external hard disk drive, to your netbook.

General safety rules

Before connecting a peripheral to your netbook, please refer to the installation instructions provided with the device.

A Never remove a peripheral while your eCAFE™ is reading or saving data; you would risk destroying the data beyond repair.

USB ports (Universal Serial Bus)

The eCAFE™ features three USB 2.0 ports (USB 1.1 compatible), to which you can connect many peripherals such as a keyboard, a mouse, a
USB key and more. This interface is hot-swappable, allowing you to connect and remove your peripheral without having to first shut it down.
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A If you have connected a USB external hard disk drive to your eCAFE™, please click on the N icon (located in the lower right section
of the screen) and select "Remove media" prior to disconnecting your peripheral.

A The system may fail to recognise some USB peripherals if they have been connected during the computer's start-up phase. Should this
be the case, please remove the device from your netbook and connect it again.

Audio connectors

To initiate a communication or view a video, please connect a microphone, headphones and/or a headset featuring a built-in microphone to the
relevant connector:

- The jack output connector to connect headphones or a headset

- The jack input connector to connect an MP3 player for recording purposes, or a microphone to record vocal data or chat with your contacts
using a voice-over-IP application

Local Area Network (LAN)

The eCAFE™ is equipped with a RJ45 LAN connectivity interface, which enables you to connect it to a 10/100 Mbps wired network (corporate
network, router, wired modem & router or Internet box, for instance).
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2.5 A desktop device AND a mobile device

Both a desktop device and a mobile device at once, the eCAFE™ can be used everywhere thanks to its dual power supply (mains or battery).
2.5.1 Operating the eCAFE™ when connected to the mains

Use the included power adaptor to power your eCAFE™. The device complies with the specifications of the electric network in the country in
which the device was purchased.

A Please make sure that the power supply plug is fully engaged into the computer's power supply connector.

i

When the eCAFE™ is connected to the mains, the device's battery starts to charge automatically. Please note that fully charging the eCAFE™
while the device is in use requires more time than when the eCAFE™ is turned off.

2.5.2  Operating the eCAFE™ with the built-in battery

The eCAFE™ s designed to operate on its built-in battery. When fully charged, the built-in battery guarantees ample autonomy (over 5 hours*).
You can purchase additional batteries from your sales output.

A To extend your battery's lifespan, we recommend that you charge it fully when using your eCAFE™ for the first time. Please refer to the
battery charge status indicator for more information regarding the battery charge level.

* Battery life calculated based on a simulation in which the following activities were carried out in succession: word processing, Internet browsing, standby mode approximately 5
minutes per hour of use. Battery life duration may vary and depends on how eCAFE™ is used (types of use, network conditions).
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253

Installing and removing the battery
You may need to install or remove the battery, e.g. when replacing the battery.

ECAFE"

A Before installing or removing the battery, place the locks (2) in the "Unlocked" position; install or remove the battery, then place the
locks in the "Locked" position again.
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AAlways shut your eCAFE™ down before installing or removing the battery!

A Use only Hercules batteries that are fully identical to the original batteries included with your eCAFE™. Failure to comply with these
instructions may cause damage to your eCAFE™. Similarly, there is a risk of explosion if the battery is replaced by an inappropriate battery.

Please comply with the regulations on proper battery disposal.
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2.5.4  Optimising your use of the battery

This nethook battery pack uses lithium ion (Li-lon) battery cells and can be charged at any time. If you will not be using the netbook for 30 days,
please remove the battery pack from the netbook. The battery should be at over 70% of its capacity before you remove it. The recommended
storage temperature of a Li-hased battery is 5°C~35°C. It should not be stored in a hot car. The Li-lon battery pack deteriorates whether or not
it is used. Typical life is 2~3 years.

To extend your netbook battery's lifespan:
- Adjust the display's luminosity to a level suited to your environment (indoors/outdoors) and to the application that you are using.

| [

—
ol

+
4

- Close the display when you are not using your eCAFE™ for a short time. The display will automatically turn off,

Increase display
brightness

- When using your eCAFE™ for the first time, always charge the battery entirely.

- Deactivate the WiFi function if you are not using WiFi networks.

!L‘ﬂﬂ Deactivate WiFi
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3. FIRST STEPS WITH MY eCAFE™

3.1 Turning the eCAFE™ On/Off

Turning the device on
- Open the display (1) and press the On/Off button located on the right-hand side of the device (2).

A Do not exert excessive strength on the hinges when opening the display. Do not hold your eCAFE™ by the display when carrying the
device.

Communication World Multimedia World

24 R

SCArE
7

H.
A

eCAFE™ Portal

Work'Walrd

When your computer starts up, the Home world is displayed; this page is the starting point of your journey throughout the eCAFE™ galaxy. You
will have the opportunity to discover many other worlds, each world being dedicated to a specific use: Work, Communications, Games,
viewing Multimedia contents and configuring or modifying your netbook's Settings.
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Shutting the device down

- Before shutting your eCAFE™ down, make sure that all your programs and applications have shut down tidily.

1
- Shut your eCAFE™ down by clicking on the ‘J icon in the lower left-hand section of the screen, then select Shut computer down.

Forcing the computer to shut down or restart ]
If you have trouble starting your computer up, press the device's On/Off button and hold it down until your eCAFE™ shuts down.

Ctrl
If an unexpected configuration prevents your eCAFE™ from reverting to its initial state when you press the B key, press keys D+
+ simultaneously. The system will then proceed to restart the various worlds; this quick restart lasts only a few seconds.

A Do not use the forced shutdown or restart procedures when files are open. Irreparable loss of data may occur in this case.

3.2 Connecting an external display

When you are at home or working at the office, you can connect your nethook to a larger screen, e.g. to surf the Internet or work on large
spreadsheets. To do so, simply connect your eCAFE™ to a VGA screen using the device's VGA connector. For more information regarding
display settings, please refer to the Personalisation Wizard in section 3.7.2., "Extensive contents to take you further").
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3.3 Connecting a keyboard and a mouse

You can also connect a keyboard and/or a mouse to the device's USB ports.

3.4 Connecting headphones and a microphone

To fully enjoy your music and movies or to chat with friends, you can connect headphones or a speaker kit to your netbook (3.5-inch jack
connector).

& Connecting an audio peripheral automatically deactivates the microphone or speakers eCAFE™'s built-in speakers.
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3.5 Mastering the touchpad

Some actions are confirmed by a single click (activating a button or accessing a menu, for instance):

Either by pressing the left touchpad button once

Either by briefly tapping the touchpad

Other actions are confirmed by means of a double-click (opening audio or video contents or a document, for instance):

Either by pressing the left touchpad button twice

Either by briefly tapping the touchpad twice

The right touchpad button is generally used to access the selected object's properties.
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3.6 Accessing the help interface

This guide is available in the "User's Manual" PDF file located on your eCAFE™'s hard disk drive (in the folder named "MyFiles", which
contains your personal files).

Specific help is also available within each installed application. Please refer to the relevant help section if necessary.

3.7 Welcome to the eCAFE™ galaxy!

Communication World Multimedia World

&
<
&2

ecare
v

m.
A

eCAFE™ Portal

Flay Woarld WorkWalrd

3.7.1  Allthe essentials in just one click

When your computer starts up, the Home world is displayed:; this page is the starting point of your journey throughout the eCAFE™ galaxy. You
will have the opportunity to discover many other worlds, each world being dedicated to a specific use: Work, Communications, Games,
viewing Multimedia contents and configuring or modifying your netbook's Settings.

&j
72

The "=~ icon opens the eCAFE™ portal, which allows you to access your online world, view detailed information about the eCAFE™
solutions range, discover new applications, obtain hints and tricks, learn whether your netbook is compatible with your equipment or simply
discover new uses for your system.

On the left-hand side of the screen, an icon bar enables users to quickly access the various applications and worlds.

All applications can be accessed by clicking on the 5 icon.

You can access the eCAFE™'s graphic preferences by clicking on the icon.
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Switch to the Home world key Access the Home world

5 Access all applications directly
LU

Access the Communications
world

Access the Personalisation Access the Games world

Wizard to customise your

netbook's settings N

Open the File Browser ﬁ J _J Access the Multimedia world
e 1 Open the eCAFE™ portal . 4 Access the Work world
ecare N 4
e <t

Access the Settings world

- The Home world

Communication World Multimedia World

ECAFE

L

eCAFE™ Portal

Pla_y Warld Waork Wolrd
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- The Communications world

Web Browser Connections Web Radios

Mo

w
8 [

Email Messaging Instant messenger

- The Games world

THE:

Connect 4 Sudoku Minesweeper

v @

: -

Solitaire Bubble Bash Brain Challenge

'._,

Top Game by Gamelatt.
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- The Multimedia world

Photos Manager Drawer External DVD Reader

Video Player Music Player Webcam

- The Work world

€

Bank Account Manager Text Editor Spreadsheet

Cone

PDF Reader Schedule Presentations
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- The Settings world

L

&

Computer Configuration Customisation

. ?

E r

Antivirus Terminal

Volume 'Cantrol
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3.7.2  Extensive contents to take you further

Users wishing to explore all the eCAFE™'s possibilities will enjoy the wide range of office and communication tools and games; the eCAFE™'s
world can even be customised using user-friendly and intuitive tools.

The Personalisation Wizard

Launch the Personalisation Wizard

Click on the icon in the upper left section of the screen to open the Personalisation Wizard, which enables you to:
- Adjust screen resolution and select an output display on the Screens and resolutions thumbnail
- Add quick access links to your favourite applications on the Desktop thumbnail
- Customise the Home world by changing the background image on the Background thumbnail

- Configure your screensaver on the Standby thumbnail

A To customise your Home world using a background image (without deformation or unwanted pixels), we recommend you select an
image with a resolution of 1024x600 pixels.

Direct access to all applications

Access all applications directly

This menu is accessible from the application quick launch bar. It enables you to access all installed applications via an interface featuring an
array of menus and submenus.

The File Browser

—

Iqﬁ Open the File Browser
5
The File Browser enables you to access all the files stored on your eCAFE™ and to create new files. Several file types are available: text files,
image files, audio files and video files, among others.

These files can be stored in separate directories on your eCAFE™'s hard disk drive or on an external memory unit (e.g. an external hard disk
drive, a USB key or a memory card). A folder can contain various types of files. For instance, if you create a "Birthday" directory, this folder can
contain pictures taken at the birthday party, as well as a video or the invitation card text.

Files can be created directly from the applications available on the eCAFE™:; they can also be loaded from external peripherals.

+ MyFiles - File Browser =T

File Edit View Go Bookmarks Help

- % - || # k_ il =
Back Forward Up Stop Reload Home  Computer Search
5| | = |/ MyFiles s Desktop &, 100% &,  View aslcons | v
Places~
) MyFiles
| | | | R
B Desktop
Deskto| Documents icons Images Musik
= File System & d
1 2.0 GB Media
= ”/"‘ ___,—'-" _"/"_
Wastebasket
Downloads tmp Videos

8 items, Free space: 10.4 GB
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Load my files from a USB key:

- Connect your USB key to one of the two available USB ports. The eCAFE™ automatically detects the newly connected device and
displays the USB symbol in the status bar.
- Inthe File Browser that automatically appears onscreen, click on your USB key's name (it is now displayed in the left-hand pane).

- Select the files that you wish to load (hold the == key to select several consecutive files, or hold the Ctrl key to select
several non-consecutive files).

- In the Edit menu, select Copy.

- In the File Browser, select a destination location for your files.

- In the Edit menu, select Paste.

Load my files from a memory card:

- Insert the memory card in the memory card reader. The eCAFE™ automatically detects the newly connected device.
- In the File Browser, click on your memory card's name iwhich now appears in the left-hand pane).

- Select the files that you wish to load (hold the key to select several consecutive files, or hold the Ctrl key to select
several non-consecutive files).

- In the Edit menu, select Copy.

- In the File Browser, select a destination location for your files.

- In the Edit menu, select Paste.
Load my files via a network connection:

To load files via a network connection, you must connect your eCAFE™ to a network using the Ethernet port or a WiFi connection. You can
then access the relevant files via the network.

Load my photos from a digital camera

- Connect a digital camera to one of the two available USB ports.

- Turn your digital camera on. The eCAFE™ automatically detects the newly connected device. The Import images from a digital
camera menu is displayed.

- Select Import photos. The Photo Manager software launches automatically.

- Select Copy. All the images stored in the digital camera are selected. They are then copied from the digital camera to your
eCAFE™'s hard disk drive (in the Images directory). The message "File copy complete" is displayed onscreen.

- Select OK.

Status bar and Notification area

The status bar displays the thumbnails of the currently launched applications, while the notification area (located in the lower right-hand section
of the screen) displays the battery's charge level and status, the network connection (WiFi or Ethernet), the status of the Caps lock and Keypad
lock keys, the CPU usage level and a clock.
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3.8 Adjusting the main settings

3.8.1 eCAFE™ Connect and the WiFi feature

. ’ﬂ Launch eCAFE™ Connect from the
Communications world
Option no. 1

Launch eCAFE™ Connect from the
status bar
Option no. 2

| Activate/Deactivate the WiFi feature

eCAFE™ Connect is a software application developed by Hercules, which enables you to manage your network connections (both Ethernet
and WiFi) in a user-friendly, intuitive way. It is the essential complement of the eCAFE™'s built-in WiFi card

-
|

To access eCAFE™ Connect (option no. 2):
- Right-click on the Hercules eCAFE™ Connect icon located in the status bar using the right touchpad button.

MNetwork connection status

Configure wireless connection

Configure Ethernet cable connection
About...
Exit

- Select Network connection status.

Fl
. ; (ta)
- Activate your eCAFE™'s WiFi feature by pressing on keys and . The computer's WiFi A indicator should light up.

(p)
& This feature is not activated when the system starts up, and the WiFi indicator A is off.

Hercules 2CAFECONNECT

Connected to
Hercules | £

- -

((l) Wireless connection:

Status: Connected to Hercules WSH"W details M

\ Ethernet cable connection:

Status: Not connected \# Show details

- Click on the Connect button facing the wireless connection.

You will now access the WiFi connection manager named eCAFE™ Connect WiFi Station. For more information regarding the WiFi connection
manager, and for more information on how to connect to a WiFi network and store your favourite networks on your computer, please refer to
section 4.1.1., "Connecting to the Internet... using the WiFi feature".
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3.8.2 Date and time
To adjust the date and time, click on the clock located in the status bar, in the lower right-hand section of the screen.

Click on the clock

The settings pane displays:
3 or Date, Clock & Time Zone Settings = O X g
«  March 12008 * oy ’
Mon Tue Wed Thu Fri Sat Sun
1. 2 _M ..f_
= 4 5 & 71 B 8 |> =
b 3 12 1\ a4 35 16 | - :
17 18 19 20 21 22 23 - ~
24 25 26 27 28 29 30 g e

31

16 (3 |12 [5125 [

Network Time Protocol
Your computer can synchronize its clock | T'Mmezone:

with a remote time server using NTP Europe/Paris

! Enable Network Time Protocol Change Time Zone
Server:| AfricalAll servers: africa.po|

Cancel Reset Ok

3.8.3 Language

To select the interface language, access the Settings world, and then click on Computer Configuration.
The Control Centre displays. Select the System thumbnail, and then click on the Manage your system's local settings icon.

Select a language in the displayed list. Click on Next, then Next again, and then click on OK to confirm your choice.

3.84 Volume

Click on the volume icon located in the status bar.

Click on the volume icon

You can also click on the applications quick access iconH . Select Settings, then Volume control.
The settings pane displays.
3.8.5 Printers

Access the Settings world, then click on Computer Configuration.

The Control Centre displays. Select the System thumbnail, then click on the Configure printer(s) icon. Follow the instructions displayed
onscreen.
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3.9 Customising your world

3.9.1 Defining user profiles
Access the Settings world, then click on Computer Configuration.

The Control Centre displays. Select the Security thumbnail, then click on the Manage the system'’s users icon.

3.9.2 Customising the interface's appearance

J Launch the Personalisation Wizard.

The Personalisation Wizard enables you to easily add quick access links to your favourite applications, or to customise the appearance of the

Home world by changing the background image. This application is accessible via the icon located in the upper left-hand section of
the screen.

To add quick access links, access the Desktop thumbnail and select your world (upper left-hand section of the screen). This list of
applications currently featured in this world displays onscreen. To add an application, select the chosen application in the right-hand list and
drag it towards the world.

To change the background image:

- Access the Desktop thumbnail.

- Select the Home world.

- Click on the image that appears at the bottom of the window, then click on the Browse button.

- Select the location of your image file (the recommended image size for optimum display quality is 1024x600 pixels).
- Click on OK to apply the new background image.
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4, COMMUNICATIONS

Access the Communications world.

Web Browser Connections Web Radios

o

w
8 [

Email Messaging Instant messenger

4.1 Connecting to the Internet

4.1.1 ..using the WiFi feature

Connect to the Internet with unrivalled ease — and without cables — thanks to eCAFE™ Connect, the software application developed by
Hercules, which enables you to manage your WiFi network connections in a user-friendly, intuitive way.

In this section, we will take a closer look at how to connect to the Internet using your netbook's WiFi feature — a feature that is hugely
appreciated by mobile users who need to connect to the Internet or check their email account at all times.

- Access the Communications world and click on Connections, or click on the Hercules eCAFE™ Connect icon located in the status bar.

The eCAFE™ Connect window opens.

" (D)
- Activate your eCAFE™'s WiFi feature by pressing on keys E and Eﬂ The computer's WiFi indicator A should light up.
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Hercules @ CAFECONNECT

Connected to
Hercules |

(( )) Wireless connection: . ; .
l Status: Connected to Hercules 65*“"” details w

Ethernet cable connection: _
Status: Not connected esmw details

We shall now proceed to locate the available WiFi networks and proceed to set up a wireless connection to the Internet.

- Click on the Configuration button facing the wireless connection.

The eCAFE™ Connect WiFi Station application proceeds to automatically locate the available networks, and displays the detected networks.

ecles 2 CAFE'CONNECT

WIFI STATION

Scanning & Status

—~ T Select your network below: - Connection Status -
Connected to:
Network . Access Point / Router
name Type =iane Secured Network name:
(ssID) Level (SSID)
- - - MAC Address: 00300ABOASEBD
Hercules Infra 88% Yes (WEP) (BSSID)
Favorites
[Name: FAVOR-1 T
Security
E-iecurity type: WEP T
M Connection
Network type: Infra
Link Quality: I

Connecting to a non-secure network (no key type appears in the Secure field):

- Select the relevant network.

- Click on the Connect to the network button.

A Connection Wizard launches, and asks you if you wish to add this network to your favourites.

- If you wish to do so, you can add the network to your favourites by checking the Yes box; you will then be requested to provide a name for the
network.

A few seconds later, a green icon displays facing the network, indicating that you are successfully connected.

If you want your computer to automatically connect to a specific network when the WiFi feature is activated, add the network to your Favourites
list and select the Connect automatically option.

28/62 — User Manual



BCAFE”

UMPC EC-900-H60G-IA

A If the connection to the chosen network fails in the Infrastructure mode, check your router's security settings (key, MAC address

filtering etc.).

Note: The Infrastructure mode is a communication mode that consists in creating a network connecting several computers equipped with
a WiFi feature via a wireless access point such as an Internet box, a modem/router or a router connected to a modem. The Infrastructure
mode is ideal for exchanging data or playing games over a network, but also for sharing an Internet connection and/or a printer between

several computers.

The Ad hoc mode is a mode that enables several computers equipped with a WiFi feature to communicate directly with each other. This

mode is also called "Peer to Peer".

A MAC address is a unique address created by the router's vendor; it serves to identify this device on a network. The MAC address is
comprised of the organisation's (i.e. the vendor's) identifier, followed by the device's unique identifier.

To connect to a secure network (a key type appears in the Secure field):

- Select the relevant network.
- Click on Connect to the network.

- Enter the security key when asked by the WiFi Station application.
- If you wish to do so, you can add the network to your favourites by checking the Yes box; you will then be requested to provide a name for the

network.

A If you wish to connect to a secure network, you must have access to the network's security key. Before the connection can be made,
the eCAFE™ Connect WiFi Station application will ask you to provide this key (a message will help you identify the required type of key).

To connect to a hidden network (the Network name (SSID) field is empty):

If, among the located networks, one or more networks do not have a name (i.e. the Network name (SSID) field is empty), this means that the

network is not broadcasting its name. To connect to this network, select it, then:

- Click on the Connect to the network button.
- Enter the network's name (SSID) in the window that displays.

- If this network is secure, enter the used security key.
- If you wish to do so, you can add the network to your favourites by checking the Yes box; you will then be requested to provide a name for the

network.

A For greater browsing comfort, you can either use your Internet browser's zoom function E" or press the F11 key to switch between
full screen mode and window display mode.

For more information about the connection's status:

The eCAFE™ Connect icon appears in the notification area. It provides updated information about the connection's status:

Internet connection: an Ethernet or WiFi
peripheral is active and physically
connected; Internet access is available.

Local connection: an Ethernet or WiFi
peripheral is active and physically

connected; no Internet access is available.

Connection problem: an Ethernet or
WiFi peripheral is active and physically

connected; no Internet access is available.

No connection: an Ethernet or WiFi
device is active but is not connected
physically.

No peripheral: no Ethernet and/or WiFi
peripheral has been activated.

Your Internet connection is perfectly
operational.

You are connected to a modem, a
router or an Internet box or to a
corporate network; however, this
device or network is not connected
to the Internet. Please check the
Internet connection settings on your
local area network or your modem.

Please check your network
connection settings (IP address,
subnet mask etc.) on your local area
network or your modem. If
necessary, contact your router's or
modem/router's vendor.

Connect your eCAFE™ to a local
area network via the WiFi
connection (please refer to the
previous section) or via the Ethernet
port.

Activate your peripheral: to activate

your WiFi peripheral, simultaneously
press on keys [Fn] and [F1] on your

netbook's keyboard.
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4.1.2 ..viaaDSL connection or a local area network

To connect to the Internet via a DSL connection or a local area network, simply connect your eCAFE™ to the DSL modem or local area
network's Ethernet port.

An information window displays in your eCAFE™'s status bar, enabling you to view the network connection. Then, launch your Internet
browser.

A For greater browsing comfort, you can either use your Internet browser's zoom function |E or press the F11 key to switch between
full screen mode and window display mode.

For more information about the connection's status:

The eCAFE™ Connect icon appears in the notification area. It provides updated information about the connection's status:

Internet connection: an Ethernet or WiFi
peripheral is active and physically
connected; Internet access is available.

Local connection: an Ethernet or WiFi
peripheral is active and physically

connected; no Internet access is available.

Connection problem: an Ethernet or
WiFi peripheral is active and physically

connected; no Internet access is available.

No connection: an Ethernet or WiFi
device is active but is not connected
physically.

No peripheral: no Ethernet and/or WiFi
peripheral has been activated.

Your Internet connection is perfectly
operational.

You are connected to a modem, a
router or an Internet box or to a
corporate network; however, this
device or network is not connected
to the Internet. Please check the
Internet connection settings on your
local area network or your modem.

Please check your network
connection settings (IP address,
subnet mask etc.) on your local area
network or your modem. If
necessary, contact your router's or
modem/router's vendor.

Connect your eCAFE™ to a local
area network via the WiFi
connection (please refer to the
previous section) or via the Ethernet
port.

Activate your peripheral: to activate

your WiFi peripheral, simultaneously
press on keys [Fn] and [F1] on your

netbook's keyboard.

4.2 Sending and receiving emails

Whether at home or "on the road", it is often useful to be able to access your email account. Once connected to the Internet, you can send and
receive emails and attachments using the Email application provided with your eCAFE™,

A Please refer to the connection information provided by your Internet Services Provider. You will need this information to configure your
email account correctly.

The Email Configuration Wizard launches when you first run the Email application, in order to help you setup your email account.
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1. Inthe Welcome window, click on Next.

(x

+ Aeegis YYizzired

e

New Account Setup

In order to receive messages, you first need to set up a Mail or
Newsgroup account.

This Wizard will collect the information necessary to set up a Mail
or Newsgroup account. If you do not know the information
requested, please contact your System Administrator or Internet
Service Provider.

Select the type of account you would like to set up:

* Email account
RSS News & Blogs
Gmail
Newsgroup account

Cancel Next

2. Enter your name. This information will appear in the emails that you will send. Also enter your email address (please make sure that it is
valid). Click on Next.

f POy
+ Aneils Yimzire] X

Ry

Identity

Each account has an identity, which is the information that
identifies you to others when they receive your messages.

Enter the name you would like to appear in the "From" field of your
outgoing messages (for example, *John Smith").

Your Name: eCafe

Enter your email address. This is the address others will use to
send email to you (for example, "user@example.net”).

Email Address: ecafe@mail.com

Cancel Back Next
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3. Select the incoming server type (POP or IMAP). Enter the names of the incoming and outgoing mail servers, which respectively deal with
receiving and sending your emails. Click on Next.

£ Ao YYi<zire] X

e

Server Information

Select the type of incoming server you are using.

* POP IMAP

Enter the name of your incoming server (for example,
"mail.example.net").

Incoming Server: | mail.com
Uncheck this checkhox to stare mail for this account in its own
directory. That will make this account appear as a top-level

account. Otherwise, it will be part of the Local Folders Global
Inbox account.,

¥| Use Global Inbox (store mail in Local Folders)

Enter the name of your outgoing server (SMTP) (for example,
"smtp.example.net").

Qutgoing Server: | mail.com

Cancel Back Next

4. Enter your user name (as it appears on the printed material provided by your ISP). Click on Next.

- Account Wizard

—

User Names

(x

Enter the incoming user name given to you by your email provider
(for example, "jsmith").

Incoming User Name: | ecafe
Your outgoing (SMTP) server, "mail.com”, is identical to your
incoming server, your incoming user name will be used to access it.

You can modify outgoing server settings by choosing Account
Settings from the Tools menu.

Cancel Back Next
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5. Review your email account's information. Click on Finish.

-

=+ Account Wizard

b

Congratulations!

(x

Please verify that the information below is correct.

Account Name: home

Email Address: ecafe@mail.com
Incoming User Name: ecafe

Incoming Server Name: mail.com
Incoming Server Type: POP3

Qutgoing User Name: ecafe

Qutgoing Server Name (SMTP): mail.com

¥ Download messages now

Click Finish to save these settings and exit the Account Wizard.

Cancel Back Finish
6. Your email account appears onscreen.
& Email Messaging = 0X%
File Edit View Go Message OpenPGP Tools Help %
5 - C :
= . / LQJ ! N i 42 Subject or Sender
Get Mail  Write Address Book | Decrypt Reply Reply All Forward | Delete  Junk Print Stop
All Folders S | ‘ ] | Subject ‘6—0‘ Sender ‘ﬂa | Date - | E3|
= i Local Folders
= Inbox
# Unsent
] Trash

Welcome to Thunderbird!

Mozilla's Thunderbird email application is more powerful than ever. It's

now even easier to organize, secure and customize your mail.

Experience the difference. Thunderbird is developed and supported by Mozilla, a

global community working together to make the Internet a better place for
everyone,

For frequently asked guestions, tips and general help, visit Thunderbird Help
Center.

-

Unread: 0 | Total: 0 |

7. To check if you've received any new emails, click on Get Mail. The system will ask you to provide your email login and password. If an error

message displays, you can modify your email account's information by accessing Edit-Account settings.
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Email
Window menu
Enables you to minimize or move
. ) Menu bar it
the window, for instance, or Minimize, Reduce
move it to the foreground Offers access to allfeatures or Close the window

Information regarding the message

i Email M.e.ssagiﬁg
|Ei|e Edit View Go Message OpenPGP Tools Help [

Reply to a message mode: Junk or Acceptable:
Allows you to reply to the sender flags the selected file as
ﬁt:i::::r new (Reply), to the sender and all recipients J'-"ak (Susﬁ'Clan content)
» (Reply to all) or to transfer the message ~ Of flags a Junk file as Stop:
Checks outgoing and ~ Addresses: L - .
incoming messages Opens the tthe chosen resipients Acceptable Stops transferring
address book amessage

>y - 4 ¢ - . . Subject or Sender
Get Mail  Write Address Book @ Decrypt Reply Reply All Forward | Delete  Junk Print Stop -
I I
Write: Unscramble: Delete: Print:
0" o dow in which Unscrambles or verifies the Deletes the message or Prints the selected
PEns a window in whic message using OpenPGP the selected directory message

you can type your
message and add recipients
and attachments

Directory list

All Folders « vl | & | i [ Subject |m| Recipient |M | Date -|l'$|
|= & Local Folders |- (no subject) - john.chocolate@mail.com - 14:58

& Inbox
~ Unsent
»~ Drafts List of messages included in the selected folder
1 Trash

= Subject: (no subject)
From: eCafe <ecafe@mail.com> :
Date: 14:58 Edit Draft...
To: john.chocolate@mail.com

H1 John

Message text

. ' Unread: 0 | Total: 1
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4.3 Chatting with friends

Instant messaging has become an essential communication tool, which allows you to chat in real time with your friends or colleagues (i.e. your
Contacts). This is why the eCAFE™ features Pidgin, a multi-protocol instant messaging service that is compatible with the most common
instant messaging applications.

The Pidgin configuration wizard launches when you first run the instant messaging application, in order to help you setup your instant
messaging account.

1. Click on Add.

Accounts X

+

Welcome to Pidgin!

You have no IM accounts configured. To start connecting with
Pidgin press the Add button below and configure your first
account, If you want Pidgin to connect to multiple IM
accounts, press Add again to configure them all.

You can come back to this window to add, edit, or remove
accounts from Accounts=Add/Edit in the Buddy List window

- Add . Modify Delete = 3 Close

2. In the Protocol drop-down list, select your instant messaging service (e.g. MSN).

4 Add Account

e

(x

Basic | Advanced

Login Options

Frotocol: - AIM =
@ Gadu-Gadu |
Screen nhame: |
&5 Google Talk |
Password: [n| GroupWise
= 9 1CQ
Local alias: S IRC
Remember %7 MSH
User Options e E;Spacell\ﬂ
New mail ng
= @ SIMPLE
Use this bu ww xmpp account:
| ¥f Yahoo
“= B = Zephyr

egancel

Save
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3. Enter your username, your password and a local nickname (i.e. the name that will appear in your friends' contacts list).

sl

+ Add Account X

Basic | Advanced

Login Options

Protocol: % MSN -
Screen name: john.cafe@msn.com
Password: SooOConn

Local alias: my account

Remember password
User Options
New mail notifications

¥ Use this buddy icon for this account:

&) Cancel igave

4. In the User options section, you can customise your account by adding an image. Check the Use this buddy icon for this account box and
click on the suggested image to access the File Brower interface; then, select the image you wish to use in any of your directories.

5. Your instant messaging account's configuration procedure is almost finished. Click on Save.

6. Your instant messaging account appears onscreen.

Note: Your instant messaging account remains accessible via the icon located in the notification area, in the lower right-hand section of the
screen, until you definitely close Pidgin.
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Pidgin
Window menu
Enables you to minimize or move Minimize. Reduce
the window, for instance, or or Close ’the window
move it to the foreground
Menu bar -+ Buddylist [ O X
Offers access to all features —— Buddies Accounts Tools ﬂelp—|
v Individuals
() C=line E
; @ E
Contacts list W-ude
To send a message to a B i L
@ gaelle
contact, double-click on . ——
the contact and enter the © Greg -
text in the new window.
To add a contact, @ kathy
press Ctrl + B
Custom image
: Click on this image
() Available [ oW to modify it

Account status
Click on the arrow to select
a status in the displayed list.
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5. GAMES

Access the Games world.

¢f °

Connect 4 Minesweeper

’

Solitaire Bubble Bash Brain Challenge

'._.

Top Game by Gameloft

The eCAFE™ offers a selection of popular games, as well as two games developed specially for your eCAFE™: Brain Challenge and Bubble
Bash.
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6. MULTIMEDIA

Access the Multimedia world.

&

Photos Manager Drawer External DVD Reader

G"@ ; Q

Video Player Music Player Webcam
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6.1 Viewing and organising your photos

"_ .I _.-‘j|
¥
Your eCAFE™ features a comprehensive photo management tool. You can import new photos, sort your photos by date or tag them in order to
sort them by category.

Launch the Photos
application

Window menu

Enables you to minimize or
move the window, for instance,
or move it to the foreground

Minimize, Reduce
Menu bar or Close the window
Offers access to all features
Application name

s Photo Manager

rt

|file Edit View Find Tags Help |

Import: B ) Fullscreen:

Import images from the D’ro“rse.h , Display the selected image
selected directory to the isplay the images fullscreen. Press the Esc key to
Images directory as thumbnails revert to the thumbnail display.

(1>

o = 5) : —
w0 & D == [ ‘

Import Rotate Left Rotate Right Browse |Edit Image | Fullscreen
L!I Modify the image:
Select an image and rotate it left or right Select an image and click

on this button fo access

the editing options.
List of predefined tags Timeline
Atag is a marker that can be connected Once imported, the images are sorted by date (year and month). Click on one of
to an image or a group of images to the cells to display its contents. The more the cell is filled (in blue), the more
make them easier to sort. Simply drag images it contains. A white cell contains no images.

one of the tags onto the image.

Favorites

-
3
o
o
[=3]

.

I

Hidden

Location

i)
|
.

OF

People 24/07/2008 24/07/2008 24/07/2008 24/07/2008

Event

ar

version

date 24/07/2008 24/07/2008 24/07/2008

size

exposure

7 Photos “ | &

Information regarding the selected tag

40/62 - User Manual



— .
@ CAFE UMPC EC-900-H60G-IA

6.2 Viewing videos

Launch the Videos application

Thanks to the multimedia player included on your eCAFE™, you can take your favourite movies with you and view your favourite videos and
home-made holiday movies. To save time and access your favourite videos directly, you can also create playlists easily.

The multimedia player is compatible with MPEG, WMV and WMA formats and the most frequently video formats available on the Internet.

Window menu
Enables you to minimize or move
the window, for instance, or Menu bar Minimize, Reduce
move it to the foreground Offers access to all features or Close the window
Name of the loaded movie
B movie.wmv

|ﬁovie Edit View Go Sound Help I

Movie menu

To load a movie, select Movie/Open, then
access the movie file's location on the hard disk
or an external storage peripheral (USE key etc.)

Playlist:

Displays the list of your favourite movies; you can
access these instantly. Your movies can be stored
on various storage media (hard disk drive, memory
card, USB key). If the memory card or the USB key
on which the movie is stored is not inserted in your

Movie viewing window eCafé™ you will not be able to read the movie.

Playlist

Mercredi C sortieg (France

Switch between the playlist
and the selected movie's
properties

Save the playlist

a B Adjust the volume ki l > Sidebar| F| = || [¥
Stopped | 1344 / 5:16 :
Playback/Pause, M::t?os;l?:lbr::l: Disglay.’Hic!e the playlist :i\:::lisatr;dar::fr::;
Chapter/Movie controls p (or Properties) pane to A
display the movie in the playlist
fullscreen mode Move a movie
up/down
in the playlist
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6.3 Listening to music

—= 1
G‘" Launch the Music application

Enjoy a genuine digital music player including extensive playback, import and playlist creation functions. If you are constantly looking for new
audio contents, subscribe to podcast streams and never miss your favourite radio program again, or create your own personal list of Internet
radio stations.

Window menu
Enables you to minimize or move
the window, for instance, or Menu bar Minimize, Reduce
move it to the foreground Offers access to all features or Close the window
Album and track name
-+ : Cinderella - COmi'r'lg Home

"

|_MLISiC Modify View Control Help |

Music menu

To load an audio file or a directory containing music files, select Music/import
a file (or Music/Import a directory), then access the file or directory's location
on the hard disk drive or external storage device (USB key efc.)

Repeat:

Click here to resume
playback of all fracks as
soon as the last track ends

Shuffle:
Playback/Pause Listen to the tracks in the
Next/Previous track controls ;:Ll:flti';zﬂned hythe Adjust the volume

—— | —
A e g o %

Play |Previous Next Repeat Shuffle Browse
sample music.mp3 by unknown from unknown album
Information about Browse: Track length
Track playback the track (track name, Switch between the simple and
position cursor album name) detailed track display modes
when playing a
track
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Quick access to
libraries, shops,
webradios and
playlists

-

Library =
17| Play Queue
J_j Music

® Podcasts

Radio
Stores -

E Jamendo
@ Magnatune

l o

L

Specific track search area:
Enter part of the name or the full
name to display all matching tracks

i [ :" | Artists Albums

Search criteria:

Display the results matching all criteria
(artists, albums and tracks) or only the
albums, the artists or the tracks

|

Search: Titles

Artist = Album =
1 artist (1) 1 album (1)

artist album

@:lTrack]Title Genre !Artist Album Time =
" Title Metal Artist Album 4:56

|1 song, 4 minutes, 7.3 MB
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6.4 Using the webcam

Starting the webcam

Explore another side of digital communications thanks to the webcam built into your eCAFE™: take pictures and record video sequences with
unrivalled ease thanks to the included software.

Opens your webcam's
Video settings control panel
(brightness, contrast...).

Opens your webcam's Audio
settings (microphone)
control panel,

Allows you to access Webcam
Station general settings

(destination folder for recorded

images and videos, file
format...).

Affiche l'image de la
webcam en plein écran,
‘Appuyez sur |a touche [F11]
ou [Echap] du clavier pour
revenir en mode normal.
Displays the version of the
‘Webcam Station software, the
copyright and the license
agreement text.
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Volume level when using
the microphone: from 0 to
100%

Reduce or Close the window

Webcam Station

1 | Mode afection 1. Select Photo or Video
g mode.
[ 2. Select the resolution in
the drop-down menu.
2 Resolution selection 3. Press the
((2se0xz2048(5M) @) || )]
button to take the photo or
start the video recording,
3 Capture 4. Press the "
\ = ( .‘ ) @ button to stop the video
REC* 00:00:25 oy recording.

Open image folder Open video folder \

Enables or disables (mutes)

the folder containi
Opens r containing your photos or Sisribochons

your videos based on the location defined in
the general settings. g
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7. WORK

Access the Work world.

Bank Account Manager Text Editor Spreadsheet

Cone W |

PDF Reader Schedule Presentations

7.1 Creating, editing, saving and more

Included on your eCAFE™, OpenOffice is a user-friendly office application suite that allows you to create documents (e.g. letters, reports and
more), simple or complex spreadsheets and elaborate slideshows.

In the Work world, you can click on the Spreadsheet, Text or Slideshows icons to directly access the required application. Regardless of the
OpenOffice application in which you are working, you can create a new document (in this case, OpenOffice automatically switches to the
relevant application) or open an existing document.

New:
Choose the new
document type
Help
= W VI~
'_ v | rl - | I. 9
=212 -
Open:
Open an existing
document from its
location

A For further information regarding the selected application, please refer to the application's online help file; you can access this content
by pressing on F1.
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ECAFE"

711

Window menu

Enables you to minimize
or move the window, for
instance, or move it to

...A document using OpenOffice.org Writer (word processor)

the foreground

Menu bar
Offers access to all features

Minimize, Reduce
or Close the window

—

Document name

Untitledl - Oper;ofﬁce.org Writer

[File _Edit View |nsert Format Table Tools Window Help |

Close the document

Styles and formatting: I Highlighting:
Display or hide the b b ai " “°’::“ Highlights the
available styles and aragraph alignment: orreduce selected text in the
formatting window Styles, Fontand Font size Align left, centered, paragraph 0, chosen in
align right or justified indent I the palette
o | pefaur |'=  |Liberation Serif »| |12 -la 4 A . (=] E]|[l«=] [v= h - ’:
| Activate or
Font styles deactivate bullet
numbering
Save the file:
Select a location if .
. Non-printable characters:
;:)eufgﬁhsf;:z!:ﬁe Cut, Copy, Paste: Chooze to display or hide
Qick prirke Select the text and Cancel and redo: chara cters such as spaces,
ick primt: transferit(Cu) tothe  cance e fast paragraph marks efc.
Print your document clipboard, or copy it action or redo a Se.
. the previous! i arch and
Create a new file: on the previously (Copy) to the clipboard 2 celieq action replace text
Text document, selected printer before inserting it (Paste) au];omaticali
spreadsheet, slide in another location y
show or others File edit Spelicheck Table Gall
allery
a-EEE B LNaa % «D0|a el aE-FFEcEN 1 |
| I | ,
. [ . Export directly as Auto Spellcheck: Apply format: Hyperlink Navigator
Open an existing file: | ppp g, Click to activate Select the text, click Data sources
Search for alocationon | £ vourfileina | or deactivate the on this button and Display the
the har? disk drive oran format readable on automatic spellcheck  apply the formatting drawing features
external storage device most computers feature to the new text
(USB key, memory card)
Document as e-mail:
Send this document via Page preview:
a previously configured Display a preview
email account of your document
before printing it
L 1'-8---1;--2--*-3---)?---2- G T B SR it RO © SR bSO SRR LSO RO RS | i T =
; ]
: Ruler
—-
1 / Ruler
//
i
~
: Text input area
"
-5
" v
: B
a
I
4 3
Pagel/1 Default English (UK) 100% |INSRT | STD
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7.1.2  ..Aspreadhseet using OpenOffice.org Calc (spreadsheet program)

Window menu
Enables you to minimize
or move the window, for
instance, or move it to Menu bar Minimize, Reduce
the foreground Offers access to all features or Close the window
Document name

Close the document

< Untitledl - OpenOffice.org Calc

|Eile Edit View |Insert Format Tools Data Window Help |

Save the file: .
L Cut, Copy, Paste:

Select alocaion it Select the text and

YOu are saving e transfer it {Cut) to Cancel and redo: Display the

file for the first time Quick print: the clipboard, or Cancel the last drawing features.

Print your document copy it (Copy) to the action of redo a

Create a new file: on the previously clipboard before cancelled action Sort ascending and
Text document, selected printer inserting it (Paste) in sort descending: Search and replace
spreadsheet, another location Sort your data in the text or values
slideshow o others File edit Spellcheck chosen order automatically

Gallery
|
8-BEe EBdsa~Riocass ¢ @ii. e 2L S

| |

|
Document as Page preview: Apply format: Hyperlink Chart: Navigator

Open an existing ~ &-mail: Display a preview Select the text, click Click here to open
fle: Send this document | - of your document on this bution, then the Chart Wizard
Search for its via @ previously before printing it apply the format to
location on the hard ~ configured email the new text
disk driveoronan  @ccount AutoSpelicheck:
extemal storage Click to activate or
device (USB key, Export di POF fils: deactivate the
memory card) port dirctly as POF filo: automatic spellcheck
Export your file in a format featwe
readable on most computers
Number format: Reduce or increase
ing: Currency, Percent indent
ggx aon:dh_{:::enmg. or none Select one of these icons ?hl:l::!:“d:r
avaialzle styles and Paragraph alignment: Select b;m: of these }0 chnose[ : ;:ucr;‘llner the m"s"'
ing wi i Align left, centered, icons to choose a ormat for 3
formattig vindows Styles, Font and Foot size align right o justified number format for

| the cells
|

E|(E (b | &« 0| E e E - i

_"J....i'bera.ii-on' sans |' [10 ] -

[q)

| | Number format: |

Merge cells:

Font styles &Ig?semal ::::i;r::no::e gi?c?!o: the arrow
cells and click P to choose a border,
here to merge then select the
them into one cell required cell(s)
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Function Wizard
Current cell's Helps you enter  Equals
name box formulas function
| |
AL [~ fo 2 = |
A B | c | D E |
;' Sum
Inserts the Sum :
3 A Formula input line
2 formula
5
6
T
8
9
10 Data input cells
11
12
13
14
15
16
17
18 Active spreadsheet
19 L
W77 [F\Sheet1 [ Sheetz [Sheet3 'l
Sheet1/3 Default 100%
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7.1.3 ...Aslideshow using OpenOffice.org Impress (slideshow creator)

We shall now create a simple slideshow in 5 steps, using the Presentation Wizard that launches when you click on the Slideshows icon
located on your desktop.

1. Create a slideshow from a template. Choose one of the available templates, then click on Next.

3 Presentation Wizard (Introducing a New Product)

Type
i1 Empty presentation

Of :

1 Open existing presentation

Introducing a New Product

Presentations = ‘ Title

Introducing a New Product
Recommendation of a Strategy

Preview

[ ] Do not show this wizard again

Help | | Cancel | ‘ == Back | ‘ Next == | | Create

2. Choose your background. Click on Next.

+ Presentation Wizard (Introducing a New Product) -

Select a slide design

Select an output medium

|Presentatmn Backgrounds - = Introducing a New Product
<Original= =
Dark Blue with Orange =
Subtle Accents —
— Title
=

w1 Original 1 Screen
I ssssseeee—————————————
Overhead sheet Slide .
-~ Ox © - Preview
i1 Paper
Help | | Cancel ‘ | <<= Back | | ‘ | Create
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3. Select a Slide transition and the speed of the transition between two slides. Click on Next.

+ Presentation Wizard (Introducing a New Product)

Select a slide transition

Effect = =
- |Nﬂ e = = Introducing a New Product
Speed |Medium - =
=
Select the presentation type -
Default = LiE:
o =
1 Automatic B
Duration of page ‘DD:DD: 10 |‘ __
Duration of pause ‘DD:DD:lD |‘ vl Preview
Show logo
Help | ‘ Cancel ‘ | << Back | ‘ ‘ | Create

4. Enter the information that you wish to include in your slideshow. You will be able to amend this information after. Click on Next.

+ Presentation Wizard (Introducing a New Product)

Describe your basic ideas

What is your name or the name of your company?

|my company

What is the subject of your presentation?

|Financ25|

Further ideas to be presented?

Help | | Cancel

== Back ‘ ‘

MNext ==

Create
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5. Select the pages that will comprise the structure of your slideshow. Click on Create.

& Presentation Wizard (Introducing a New Product)

Chgose your pages
Title

Next Steps of Action

Long-term Goal — Finances

Custormer Wishes =

Fulfiling Customer Needs =

Cost Analysis =

Strengths and Advantages - Iy CO mpary
=

¥ Preview

[ | Create summary

Help | | Cancel ‘ | << Back | ‘ MNext == | |

Your slideshow is now displayed in OpenOffice.org Impress. You can now finalise your presentation by creating objects, connectors, etc.

B Untitledl - OpenOffice.org Impress =0 %
File Edit View Insert Format Tools Slide Show Window Help X
|f-e@e B RS viBa-4% ¢ 24 "
EE(-E ;I.; = - | = | 0.00cm |3 |-Biack = | 8‘)] |Cdl0r = |- Blue 7 ¢|
Slides = |Nurmal| Cutline | Naotes | Handaut | Slide Sorter | Tasks View - X
= [« | b Master Pages
1 + Layouts

-

L
!

Finances

THT T THET

my company

)
E‘[Me:Fchers - F... I@[Musm Player (... IH[GIMF] |Q[:aptureu en - ... W‘

|+

= b Custom Animation
i3] b Slide Transition

BB -8

| prs-novelty
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Window menu
Enables you to minimize -
or move the window, for Menu bar Minimize, Redqoe
instance, or move it to Offers access to all features or Close the window
he foreground Document name Close the document
+ Untitledl - OpenOffice.org Impress
[Eile Edit View Insert Format Tools Slide Show Window Help]
Save the file:
Select a location if you Cut, Copy, Paste:
are saving the file for Select the text and Cancel and redo:
the first time: P transfer it (Cut) to Cancel the last
Quick print: . !
Print your document the d!fbg:'d' 'i'r " actionorredo Spreadsheet:
Create a new file: on the previously ;ﬂpg'ql Ed bifvg o the a cancelled action Insert a spreadsheet
Text document, selected printer in:ar‘ﬁi | betore in your presentation
g it (Paste) in Zoom:
spreadsheet, o another location Select your zoom by
slideshow or others File edit Spelicheck | Hyperlink clicking on the amow
|
- = B K] L i = : W - - “ollfesss I e R 8 - B
|2-s@a B Es 2@ioa is ¢ dT@ i ¢+Q- &)
o |
Document as e-mail: Apply format: Cha| 1t Navigator Help
Openan Send this document Auto Spellcheck: Select the text, dlick Click here to . .
existing file: V123 PI’EWOUSW_ Click to activate or on this button then apply open the Display grid
Search forits  configured email deactivate the automatic the format fo the new text Chart Wizard
location on the  @ccount spellcheck feature
hard disk drive
or on an extemnal Export directly as PDF file:
storage device Export your file in a format
(USB key, readable on most computers
memary card)
Styles and formatting:
Display or hide the
available styles and Line creation parameters
formatting windows
@ i ‘.;‘ + —— 4 000cm 5 IMBlack 2 }:"}] Color 3 |-Blue7 = O
A — _ e _— U o — "
[ Shadow:
Filling parameters Click to add a
of the selected shadow to the
object (a drawing selected text

for example)
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Layout templates, animation
Slide navigator Display modes and transition parameters
. |
|Normnl| outhne | Notes | Handout | Slide Sorter | Tasks View - X
|| » Master Pages
| 7layouts = |
— &
Finances !
= | —
& L=
bt \1
my company :
. | L
- |
Long-term ... L (i —
= E
'~ ¥ Custom Animation |
=l = { | {» > Shide Transition
s — »
/~BAOTIN-L-|0-0-«-B-B-%- D2 0ks Sk -8 ]
i i I |
| 29, ; 00X 0 % | * Shide 177 | prs-novelty |
Tools for creating lines, o Insert abjects and drawings Rotate the :“““g:m’
Selection lines ended by arrows,  Tools for creating selected object ected object
To select rectangles, ellipses lines and curves:
texl't zones, and text objects Click on the arrow
objects 1o display the
available tooks
Align the
selected object
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7.2 Managing your bank accounts

Manage your bank accounts from home with the HomeBank application provided with your eCAFE™,

Window menu

Enables you to minimize or
move the window, for instance,
or move it to the foreground

Minimize, Reduce
Menu bar or Close the window
Offers access to all features

Document name

_‘_-t HomeBank - (Nobody) (*untitled.xhb)

|H[e Edit Display Transactions Reports ﬂe1p|

View the operations on the

Create a new file: Save the file: Edit payees: Edit archives: selected account:
Text document, Select a location if Add or remove payees Manage your View all operations performed
spreadsheet, you are saving the to whom you can issue wallet's information on the selected account over
slideshow or others file for the first time bank transfers, etc. agiven time range
L Jonie 3 ¥ - wi e L Ll .
l _____________ N EW ______________ Open,., Save Accounts... Payees,,. Categories... Archives... Budget,,, Show...
Edit accounts: Edit budget:
Open an existing file: Add or remove accounts Manage your
Search for a location on ) ) budget according
the hard disk drive or an Edit categories: to the defined
external storage device Add or remove categories
(USB key, memory card) expense categories
Accounts summary
Account istate Bank Todayi Future | =
< Bank accounts £ 100,000.00 £ 101,100.00 £ 101,100.00
my account £ 100,000.00 £101,100.00 £ 101,100.00

\

Accounts and operations visualisation windows

Upcoming automated transactions

Payee | Description ' Amount | Next an; * Remaining . .....
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7.3 Managing your schedule

The Schedule application allows you to take your schedule with you, to make sure that you will never forget an important event. You can very
quickly fill in your tasks list or manage your schedule (meetings, appointments etc...) over several weeks.

Window menu
Enables you to minimize or

move the window, for instance, Minimize, Reduce

g Menu bar or Close the window
ormove it to the foreground Offers access to all features

Information about the document

b Schedule o=
File Edit View Go Tools Help |
Create a new task: Display mode:
Add a task to your tasks list Today, Day, Week, Several weeks, Month
B ¢ ~ - - —
Fe2] &= || B8 m B &
New Event New Task| Edit Delete || Today Day Week Multiweek Month
Createa nlw event: Edit or delete
i, selected element (event or task)
Create an event (meeting,
conference efc.), that will be
inserted in the calendar
Display settings: .
Current Display all events, the events for today, E‘“’?“;’W" a;“;h o i ok iy "SRG S
calendar  List of calendars the events scheduled in 7 days... o instance, enter "for”to dispiay only “forum- even
Date calendars All Events 4 contain
Title | start | End | category | =]
¢ March 2??: ¥ |([meetimg Tue 25 Mar 2008 16:00 Tue 25 Mar 2008 17:00 Business
SUMo TLEWE Th Er 5;"‘ forum Fri 14 Mar 2008 16:00  Fri 14 Mar 2008 17:00
Results matching the criteria above
2345678 = = -
- Wednesday Thursday Fl'lday Saturday Sunday S
9 10 11 12 13fF 15
14 Mar
16 17 18 19 20 21 22 Friday
23 24 25 26 27 28 29
30 31
08:00 =]
- - 09:00 Daily calendar
Tasks 10:00
Hide Completed Tasks 11:00
Tasks list — [ t[ Title [m] 12:00
[0 meeting 13:00
14:00
15:00
16:00 | forum |
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8. INSTALLING APPLICATIONS

A To install new applications or updates on your eCAFE™ netbook, you must connect to the Internet via a WiFi connection or use the
Ethernet port to connect to a modem, an Internet box or a corporate network connected to the Internet, for instance. Your netbook will use
this connection to search for all available applications on a dedicated server.

To install new applications or updates, access the Settings world, then click on Computer Configuration.

The Control Centre displays. Select the Software Manager thumbnail, then click on the Add and remove software thumbnail.

A Before allowing the installation, the application may request that you enter the user account password (the default password is "ec-
900") and the administration account password (the default password is "root").

- Select the relevant applications category in the list: Office, Development, Graphics, etc.
Packages (lists of applications) matching the selected category are displayed.

- Select a package to view its description.

- Check the box to select the package that you wish to install.

- You can also install the required additional packages, if necessary.

- Click on Apply.

- Confirm the installation by clicking on Yes.
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9. SAVING AND RESTORING DATA

In the following sections, you will learn how to create backups on various types of storage media and learn how to restore your data using
these backups. You can also connect to the www.hercules.com website. In the section dedicated to the eCAFE™, you will find all the relevant
information required to create your backups.

A We also recommend that you frequently create backups of any personal or sensitive data that you may have stored on your netbook.

9.1 Creating backups on a USB key

- Connect the USB key to one of the two available USB ports. The eCAFE™ automatically detects the newly connected device.

- In the File Browser, select the files and/or directories that you wish to backup (hold the key to select several consecutive files, or
hold the Ctrl key to select several non-consecutive files).

- In the Edit menu, select Copy.
- In the File Browser, click on the name of your USB key (which now appears in the left-hand pane).
- Choose the destination location for the files.

- In the Edit menu, select Paste.

9.2 Creating backups on a memory card

- Insert the memory card in the memory card reader. eCAFE™ automatically detects the newly connected device.

- In the File Browser, select the files and/or directories that you wish to backup (hold the EI key to select several consecutive files, or
hold the Ctrl key to select several non-consecutive files).

- In the Edit menu, select Copy.
- In the File Browser, click on the name of your memory card (which now appears in the left-hand pane).
- Choose the destination location for the files.

- In the Edit menu, select Paste.

9.3 Creating backups on a CD or DVD
- Connect a CD/DVD drive to one of the two available USB ports. The eCAFE™ automatically detects the newly connected device.
- Launch the application External CD/DVD Drive using the quick access icon.

- Create a backup project.

- In the File Browser, select the files and/or directories that you wish to backup (hold the key to select several files in a row, or hold
the Ctrl key to select several non-consecutive files).

- Click on the Add button.
- Insert a blank CD or DVD in the CD/DVD drive.

- Click on the Burn button.

9.4 Restoring backup data from a USB key
- Connect the USB key to one of the two available USB ports. The eCAFE™ automatically detects the newly connected device.

- In the File Browser, click on the name of your USB key (which now appears in the left-hand pane).

- Select the files and/or directories that you wish to restore (hold the EI key to select several files in a row, or hold the Ctrl key to select
several non-consecutive files).

- In the Edit menu, select Copy.
- In the File Browser, select a destination location for your files.

- In the Edit menu, select Paste.
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9.5 Restoring backup data from a memory card
- Insert the memory card in the memory card reader. eCAFE™ automatically detects the newly connected device.

- In the File Browser, click on the name of your memory card (which now appears in the left-hand pane).

- Select the files and/or directories that you wish to restore (hold the key to select several files in a row, or hold the Ctrl key to select
several non-consecutive files).

- In the Edit menu, select Copy.
- In the File Browser, select a destination location for your files.

- In the Edit menu, select Paste.

9.6 Restoring backup data from CD or DVD

- Connect an external CD/DVD drive to one of the two available USB ports, and insert the CD or DVD containing your backup data. The
eCAFE™ automatically detects the newly connected device.

- In the File Browser, click on the name of the CD/DVD drive (which now appears in the left-hand pane).

- Select the files and/or directories that you wish to restore (hold the key to select several files in a row, or hold the Ctrl key to select
several non-consecutive files).

- In the Edit menu, select Copy.
- In the File Browser, select a destination location for your files.

- In the Edit menu, select Paste.
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WARNING

A Read the following warnings before you or your child play video games.

Always observe the following recommendations when playing video games.
Avoid playing if you are tired or lacking sleep.
Always play in a well-lit room, and reduce the brightness of your screen.
When playing a video game on a television screen, sit at good distance from the screen, as far away the connection cable will allow.

When playing a video game, stop playing for ten to fifteen minutes every hour.

About photosensitive epileptic seizures

Some people may experience a seizure with loss of consciousness or loss of sight when exposed to intense visual stimulation, such as series
of flashing images or the repeated display of simple geometrical shapes, flashing lights or explosions.

These persons are prone to experience photosensitive epileptic seizures when playing video games featuring such visual stimulation, even if
they have no history of seizures or epilepsy.

If you, or anyone in your family, have already experienced an epileptic condition (seizure or loss of conscience) when subjected to the visual
stimulation described above, consult your physician before using a video game.

Parents should look out for, or ask their children about, the above symptoms - children and teenagers are more likely than adults to experience
these seizures. These seizures may have a variety of symptoms including light-headedness, altered vision, eye or face twitching, jerking or
shaking of arms or legs, disorientation, confusion or momentary loss of awareness. Should you or your children experience any of the above,
stop playing immediately and consult a physician.
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TECHNICAL SUPPORT

If you have trouble using your device or one of its components, please connect to the http:/ts.hercules.com/fr website and select your language. Here, you will be able to access
different services (Frequently Asked Questions (FAQs), the latest versions of all available drivers and software) that may help you solve your problem. If this fails to solve the problem,
please get in touch with Hercules' Technical Support.

Via email:

To reach our Technical Support via email, you must first register online on the http://ts.hercules.com/eng/index.php website. The information that you provide will help our technicians
solve your problem as swiftly as possible.

Click on Online Support - FAQ, then on Visit the Technical Support website, then click on Product registration and follow the instructions provided onscreen..

By telephone (if you do not have Internet access):

Monday to Friday from Noon to 4pm and 5pm to 10pm
Saturday from 9am to Noon and 1pm to 7pm

Sunday from 9am to Noon and 1pm to 4pm

- 08450800942
United Kingdom Charges at local rate

Connect to the Hercules website (www.hercules.com/fr) now to download the latest versions of all available drivers and software, view the Frequently Asked Questions (FAQs) relevant
to your product and download the latest upgrades of your product's User Manual. You can also discover the extensive range of Hercules products and download information about the
forthcoming releases.

WARRANTY INFORMATION

Guillemot Corporation S.A. (“Guillemot") guarantees consumers worldwide that this Hercules product is free from material and manufacturing defects for a period of two (2) years
beginning on the original date of purchase. Should the product seem defective during the period covered by the warranty, please contact our Technical Support immediately for further
information on how to proceed. After contacting our Technical Support, if it appears necessary to return the product to us, please return the product and its accessories in the original
packaging, well packaged and protected, according to the instructions provided by our Technical Support.

According to the terms of this warranty, following our Technical Support's decision, the defective product may be repaired or replaced. When authorised by applicable law, any liability
incurred by Guillemot and its subsidiaries (including consequential damages) will be limited to repair or replacement of the product manufactured by Hercules. The consumer's statutory
rights on account of applicable law on the sale of consumer goods are not affected in any way by this warranty.

This warranty will not apply:

(1) If the product has been modified, opened, altered in any way or damaged by inappropriate or abusive use, negligence, an accident or normal wear; (2) If the product has been used
or stored in abnormal conditions (e.g. exposition to adverse weather conditions, to direct sunlight, to water or to sand) ; (3) For any other reason not relating to a material or
manufacturing defect; (4) In the event of non-observance of the instructions provided in the User Manual or by our Technical Support; (5) To any software not edited by Guillemot, said
software being covered by a specific warranty granted by the software's editor; (6) If the warranty seals have been removed or altered in any way; (7) For damages to or the loss of
programs, data or storage media, or for the costs arising from the retrieval of said data; (8) For damages to or the loss of programs or personal data occurring after repair or
replacement of the product; (9) For damages caused by the installation of third-party software or by computer viruses.

Guillemot shall in no event be held responsible for any damage to or loss of personal data, programs, software or removable storage media. Before returning this program to Technical
Support, please create a backup of any personal and/or sensitive data. Guillemot shall in no event be held responsible for reinstalling or retrieving personal data or programs other than
those installed at the time of the product's commercialisation.

The warranty applies to your product's display if the display features at least 5 defective pixels (i.e. bright spots or dark spots, a bright spot being a white pixel permanently displayed on
the screen, and a dark spot being a pixel that does not display on the screen.)

In the event where the product is returned to out Technical Support and the warranty cannot be applied owing to the presence of one or several of the exclusion conditions stated
above, the incurred shipping and processing costs will be charged to the consumer.

Registered trademarks

Hercules® and eCAFE™ are registered trademarks of Guillemot Corporation S.A. Mandriva® is a registered trademark of Mandriva S.A.. Mozilla® is a registered trademark of Mozilla
Foundation. RealNetworks® and RealPlayer® are registered trademarks of RealNetworks Inc. Fluendo is a registered trademark of Fluendo S.A. Corel® is a registered trademark of
Corel Corporation. OpenOffice.org® is a registered trademark of Sun Microsystems Inc. Windows®, Windows XP®, Windows Vista® and the Windows logo are trademarks or
registered trademarks of Microsoft Corporation in the United States and/or other countries of the world. Intel®, Intel® Atom™ and Intel® Atom™ Inside are registered trademarks of
Intel Corporation in the United States and other countries of the world. WiFi Certified & WiFi Protected Setup are registered trademarks or brands of the WiFi Alliance. All other
registered trademarks and brand names are hereby acknowledged and are the property of their respective owners. lllustrations not binding. Contents, designs and specifications are
liable to change without prior notice and may vary according to countries.

Made in China

Statement of Compliance with EU Regulations

Guillemot Corporation S.A. hereby declares that the device UMPC EC-900-H60G-IA complies with the with the main requirements and other relevant clauses of Directive RTTE
1999/5/CE, of Directive CEM 2004/108/CE and with the standards relating to electrical security (IEC 60950, 2001 Edition / EN 60950-1, 2001 Edition / NF EN 60950, Amendment A11-
2004). The compliance statement can be viewed on the following website:

ftp://ftp.hercules.com/EC-900/H60G-IA/DoC-fra_UMPC_EC-900-H60G.pdf
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Copyright

© 2008 Guillemot Corporation S.A. All rights reserved.

No part of this manual may be copied, summarised, issued, posted, stored in a search engine or translated in any language or computer language, for any purpose or by any means
that may be, whether electronic, mechanical, magnetic, manual, by means of photocopies, recordings or others, without the express authorisation in writing of Guillemot
Corporation S.A.

End User License Agreement

IMPORTANT: Please read the following End User License Agreement before using the eCAFE™ device. The term "Software" refers to all executable programs, managers, libraries,
data files and to any documentation relating to the programs, as well as the complete operating system included in the eCAFE™ product. The Software is licensed, and not sold, to the
User, exclusively for use complying with the terms of this License Agreement. The Software is comprised of free software sub-applications provided by the Free Software Foundation
(applications, product administration programs, etc.), which are sub-licensed by Guillemot Corporation S.A. under the conditions described in point 5 above. You hereby accept and
agree to abide by the Terms & Conditions of this License Agreement. If you disagree with the Terms & Conditions of this License Agreement, please do not use the Software.

The Software is protected by international copyright laws and agreements, as well as other international laws and agreements relating to intellectual property.

The Software (excluding the software sub-applications) remains the property of Guillemot Corporation S.A. All rights reserved. Guillemot Corporation S.A. grants only a limited and non-
exclusive right to use the Software.
Guillemot Corporation S.A. reserves the right to cancel this License Agreement in the event of failure to abide by its Terms & Conditions.

License granted:

. The license is granted to the original Buyer alone. Guillemot Corporation S.A. remains the sole owner and holder of the Software (excluding the software sub-applications), and
reserves all rights that are not expressly granted by this License Agreement. The User is not allowed to sub-license the rights granted by this License Agreement. The User is
allowed to transfer this License, provided that the original Buyer retains no part of the Software and that the Transferee reads and accepts the Terms & Conditions of this License
Agreement.

. The Buyer may only use the software on one computer at a time. The machine-readable part of the Software may be copied to another computer, provided that the Software is
deleted from the first computer and that it is impossible to use the Software on several computers at the same time.

. The Buyer hereby acknowledges and accepts the copyright belonging to Guillemot Corporation S.A. The copyright shall in no event be removed from the Software, nor from any
documentation, whether printed or electronic, provided with the Software.

. The License grants the User the right to perform one (1) copy of the machine-readable part of the Software for archival purposes, provided that the User also copies Software's
copyright.

. The free software sub-applications provided by the Free Software Foundation and sublicensed by Guillemot Corporation S.A. are subject to the Terms & Conditions of the General
Public License (GPL), which is available at the following address: http://fsffrance.org/gpl/gpl-fr.fr.ntml. The source codes of these software sub-applications are available at the
following address: http:/iwww.hercules.com/fr. Some of these software sub-applications have been modified by Guillemot Corporation S.A. (the list of these software sub-
applications is available on the following website: http://www.hercules.com/fr).

. Except within the limits expressly allowed by this License Agreement, the Buyer may not agree or allow any third party to agree to: grant a sublicense; provide or divulge the
Software to other third parties; allow use of the Software on several computers at a time; perform alterations or copies of any kind; reverse engineer, decompile or modify the
Software in any way or attempt to obtain information relating to the Software that is not accessible to the User; perform copies or translations of the User Manual.
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Warranty limitation:

The Software is provided "as is", with no guarantee whatsoever from Guillemot Corporation S.A. regarding its use and/or performance. Guillemot Corporation S.A does not guarantee
that the operation of the Software will be free from interruptions or errors. The use or the performance of the Software remain under the Buyer's entire responsibility, and Guillemot
Corporation S.A. can provide no guarantee of any kind with regard to the performance and results obtained by the Buyer while using the Software. No guarantee of any kind, whether
explicit or implied, is offered by Guillemot Corporation S.A. with regard to the non-violation of third party rights, the merchantability or the adequacy of the Software to a specific use.

In no event shall Guillemot Corporation S.A.'s liability be engaged in the event of damages of any kind arising from the use or the incapacity to use the Software.

Applicable law:
The Terms & Conditions of this License Agreement are subject to French Law.

ENVIRONMENTAL CARE RECOMMENDATIONS

At the end of its useful life, this product should not be discarded with standard household refuse but should be given to a collection point for waste from electric
and electronic devices, where it shall be recycled.

This is stated by the symbol that appears on the product, the User Manual or the packaging.

According to their specificities, these materials may be recycled. By supporting recycling and other methods of recovering waste from electric and electronic
equipment, you help care for the environment.

Please consult with the local authorities, who will refer you to the relevant waste collection point.
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